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Adobe Photoshop 
 

Photoshop format (PSD) is the default file format and the only format that supports all Photoshop 
features. When saving a PSD file for use in a previous version of Photoshop, you can set a 
preference to maximize file compatibility. 
 
Photoshop provides tools for creating and manipulating static images for use on the Web. 
You can divide an image into slices, add links and HTML text optimize the slices, and save the 
image as a Web page. With its comprehensive set of retouching, painting, drawing, and Web 
tools, Photoshop helps you complete any image-editing task efficiently. And with features like 
the History palette and editable layer effects, you can experiment freely without sacrificing 
efficiency. 

You can often use the Cut or Copy command to copy selections between Photoshop and other 
applications. In Photoshop, the new paste image will be in the new layer. 

 
File Format 
 
1. JPEG: Joint Photographic Experts Group (JPEG) format is commonly used to display 

photographs and other continuous-tone images in hypertext markup language (HTML) 
documents over the World Wide Web and other online services. A JPEG image is 
automatically decompressed when opened. 

2. TIFF: Tagged-Image File Format (TIFF) is used to exchange files between applications 
and computer platforms. TIFF is a flexible bitmap image format supported by virtually all 
paint, image-editing, and page-layout applications. 

3. BMP: Bitmapped Graphics Format is a standard Windows image format on DOS and 
Windows-compatible computers. BMP format supports RGB, Indexed Color, Grayscale, and 
Bitmap color modes. 

4. PSD: Photoshop format (PSD) is the default file format and the only format that supports 
all Photoshop features. When saving a PSD file for use in a previous version of Photoshop, 
you can set a preference to maximize file compatibility. 

5. GIF: GIF file format usually provides the most efficient and flexible optimization 
controls for images which have areas of flat colour with sharp edges and types. 

6. HTML:  is the predominant markup language for web pages. It provides a means to describe 
the structure of text-based information in a document — by denoting certain text as links, 
headings, paragraphs, lists etc. 

 
JPEG   Joint Photographic Experts Group 
PSD    Photoshop Document 
TIFF   Tagged Image File Format 
BMP   Bitmap 
HTML  Hyper Text Markup Language 
RGB    Red Green Blue 
CMYK  Cyanin Magenta Yellow Black 
GIF       Graphics Interchange Format 
PNG Portable Network Graphics 

Image Mode 
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1. Grayscale: This mode uses up to 256 shades of gray. Every pixel of a grayscale image has a 
brightness value ranging from 0 (black) to 255 (white). Images produced using black-and-white 
or grayscale scanners typically are displayed in Grayscale mode. 
2. RGB Colour: RGB is an important colour model because it mirrors the way the human eye 
perceives colour. Red Green Blue are referred to as the additive primaries. You can add varying 
proportions of the three colours to produce millions of different colours. 

3. CMYK colour model : The CMYK model is based on the light-absorbing quality of ink 
printed on paper. In theory, pure cyan (C), magenta (M), and yellow (Y) pigments should 
combine to absorb all light and produce black. It is important because this is the colour model 
used by printing presses. 
 
Image 
1. Canvas Size: The Canvas Size command lets you add or remove work space around an 
existing image. You can crop an image by decreasing the canvas area. 
 
1. Image Size: In Photoshop, the Image Size command lets you adjust the pixel dimensions, 

print dimensions, and resolution of an image. 

 
Original canvas and canvas added to right side of image using the foreground color 

Change the canvas size  
The canvas size is the full editable area of an image. The Canvas Size command lets you 
increase or decrease an image’s canvas size. Increasing the canvas size adds space around an 
existing image. 

1. Choose Image > Canvas Size.  
• Enter the dimensions for the canvas in the Width and Height boxes.  
• Enter a positive number to add to the canvas, and enter a negative number to 

subtract from the canvas.  
2. For Anchor, click a square to indicate where to position the existing image on the 

new canvas.  
3. Choose an option from the Canvas Extension Color menu:  
• Foreground to fill / Background to fill the new canvas with the current 

foreground color 
4. The Canvas Extension Color menu isn’t available if an image doesn’t contain a 

background layer. 
5. Click OK.  
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Layers: Layers introduce a considerable degree of flexibility into the way in which you can 
work with images. Layers help you to keep various image elements 

Photoshop layers are like sheets of stack acetate. You can see 
through transparent areas of a layer to the layers below. You move a 
layer to position the content on the layer, like sliding a sheet of 
acetate in a stack. You can also change the opacity of a layer to make 
content partially transparent.  
 
Benefits of Layers in Adobe Photoshop 
1. Using a separate layer for each type of edit you apply to an image gives you more flexibility.  
2. Layers allow you to work on individual elements of an image without affecting others. 
3. Layers as a stack of paper, where each page represents a different layer, such as changing 

their order in the stack or making some more transparent than others.  
4. You can change the attributes of a layer by applying adjustments. 
5. Layers are separated so that you can make changes without deleting the underlying pixels. 

You can selective merge layers into each other. 
6. When you finished editing your image, you can flatten the image to merge all layers into a 

single background layer. 
7. Layer can create increases the file size of the image. Only TIFF and PSD file formats help 

you to save with layers. 
 
Photoshop Layers palette 
A. Layers palette menu, B. Layer Group C. 
Layer D. Expand/Collapse Layer effects E. 
Layer effect F. Layer thumbnail  

1. Rasterizing layers: You cannot use the 
painting tools or filters on layers that contain 
vector data and generated data However; you 
can rasterizing these layers to convert their 
contents into a flat, raster image.  
2. Layer effects and styles: Photoshop 
provide a variety of effects--such as shadows, 
glows, bevels, overlays, and strokes--that let 
you quickly change the appearance of a 
layer's contents. Layer effects are linked to the layer contents. When you move or edit the 
contents of the layer, the effects are modified correspondingly.  
3. Layer Opacity: A layer's opacity determines to what degree it obscures or reveals the layer 
beneath it. A layer with 1% opacity appears nearly transparent, while one with 100% opacity 
appears completely opaque. 
4. Fill Layers: Adjustment layers and fill layers have the same opacity and blending mode 
options as image layers and can be rearranged, deleted, hidden, and duplicated in the same 
manner as image layers.  

Layer Mode / Blend Mode (any six) 

1. Normal: Edits or paints each pixel to make it the result color. This is the default mode.  
2. Multiply blend mode which darkens images, great for restoring shadows and fixing overexposed 

photos.  
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3. Screen mode which lightens images, perfect for brightening highlights and fixing underexposed 
photos.  

4. Overlay: Multiplies or screens the colors, depending on the base color. 
5. Color Burn: each channel and darkens the base color to reflect the blend color by increasing 

the contrast. 
6. Linear Burn: each channel and darkens the base color to reflect the blend color by 

decreasing the brightness.  
7. Lighten: the color information in each channel and selects the base or blend color--

whichever is lighter--as the result color.  
8. Color Dodge: each channel and brightens the base color to reflect the blend color by 

decreasing the contrast. 
9. Linear Dodge: the color information in each channel and brightens the base color to reflect 

the blend color by increasing the brightness.  
10. Soft Light: Darkens or lightens the colors, depending on the blend color.  
11. Hard Light: Multiplies or screens the colors, depending on the blend color.  
12. Vivid Light: Burns or dodges the colors by increasing or decreasing the contrast, depending 

on the blend color.  
13. Linear Light: Burns or dodges the colors by decreasing or increasing the brightness, 

depending on the blend color.  
14. Pin Light: It replaces the colors, depending on the blend color.  
15. Difference: the color information in each channel and subtracts either the blend color from 

the base color or the base color from the blend color, depending on which has the greater 
brightness value.  

16. Exclusion: Creates an effect similar to but lowers in contrast than the Difference mode.  
17. Hue: Creates a result color with the luminance and saturation of the base color and the hue of 

the blend color.  
18. Saturation: Creates a result color with the luminance and hue of the base color and the 

saturation of the blend color.  
19. Color: Creates a result color with the luminance of the base color and the hue and saturation 

of the blend color.  
20. Luminosity: Creates a result color with the hue and saturation of the base color and the 

luminance of the blend color.  

Convert background to layers  
When you create a new image with a white background or a 
colored background, the bottommost image in the Layers palette is 
called Background. An image can have only one background 
layer. You can convert a background into a regular layer, by 
double click on the lock inside the background layer and then 
change any of these attributes.  
Lock layers: You can lock layers fully or partially to protect their 
contents. 
Duplicate layers : You can duplicate layers within an image or into another or a new image. 
Select a layer or group in the Layers palette.  
Drag the layer or group to the New Layer button . 
 
Opacity for a layer 
Fill opacity affects pixels painted in a layer or shapes drawn on a layer without affecting the 
opacity of any layer effects that have been applied to the layer. 

Blending Options 
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You can edit styles applied to a layer or 
create new styles using the Layer Styles 
dialog box. 
 

Layer Styles dialog box. Click a check box to 
apply the current settings without displaying 
the effect’s options. Click an effect name to 
display its options. 

 
Layers palette showing layer with multiple effects applied 
A. Layer effects icon B. Click to expand and show layer effects C. Layer effects  
 
1. Drop Shadow: Adds a shadow that falls behind the contents on the layer.  
2. Inner Shadow: Adds a shadow that falls just inside the edges of the layer's content, giving the 
layer a recessed appearance. 
3. Outer Glow and Inner Glow: Add glows that emanate from the outside or inside edges of the 
layer's content. 
4. Bevel and Emboss: Adds various combinations of highlights and shadows to a layer. 
5. Satin: Applies shading to the interior of a layer that reacts to the shape of the layer, typically 
creating a satiny finish. 
6. Color, Gradient, and Pattern Overlay: Fills the layer's content with a color, gradient, or 
pattern.  
7. Stroke: Outlines the object on the current layer using color, a gradient, or a pattern. It is 
particularly useful on hard-edged shapes such as type. 
 
Repeat a transformation  
Choose Edit > Transform > Again, Edit > Transform Path > Again, or Edit > Transform 
Points > Again. 
 
Working with Type (text) 
You can create and edit type directly in the image window. The type is preserved as vector 
outlines or paths (Photoshop can output type with sharp, resolution independent edges.) 
The masked type option allows you to create complex selections in the shape of type characters. 
You can choose different alignments vertically and horizontally for type, you can rotate it, fill it 
with a gradient, pattern or image and create translucent type. 
 
Type effects: It provides variety of creative technique for producing interesting effects with type. 
1. Type on a path: You can create type that follows a path created using the Pen tool or a     
     Shape tool 
2. Wrap Type: It allows you to adjust paragraph lines in both left and right margin 
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3. Word Art: helps you to design a word in different style 
 
Image Adjustment (any Five) 
1. The Auto Color adjusts the contrast and color of an image by searching the image to identify 

shadows, midtones, and highlights. By default, Auto Color neutralizes the midtones using a 
target color of RGB 128 gray and clips the shadows and highlight pixels by 0.5%. You can 
change these defaults in the Auto Color Correction Options dialog box.  

2. Levels: The Levels dialog box lets you correct the tonal range and color balance of an image 
by adjusting intensity levels of the image's shadows, midtones, and highlights.  

 
A. Shadows B. Midtones C. Highlights D. Apply 
Auto Color Correction E. Open Auto Color 
Correction Options dialog box  
Eg: 

  

1. Curves: You can adjust the tonality and color of an 
image by changing the shape of the curve in the Curves 
dialog box. [Moving the curve upward or downward 
lightens or darkens the image, depending on whether 
the dialog box is set to display levels or percentages. 
The steeper sections of the curve represent areas of 
higher contrast; flatter sections represent areas of lower 
contrast.  

 

 3. Color Balance: Drag a slider toward a color you want 
to increase in the image; drag a slider away from a color you want to decrease in the image. 

4. Brightness/Contrast: The Brightness / Contrast command lets you make simple adjustments 
to the tonal range of an image. Specify values for Brightness and Contrast. 

5. Hue/Saturation: The Hue/Saturation command lets you adjust the hue, saturation, and 
lightness of the entire image or of individual color components in an image. This command is 
especially good for fine-tuning colors in a CMYK image so that they are in the gamut of an 
output device. 

6. Selective Color: Selective color correction is a technique used by high-end scanners and 
separation programs to increase and decrease the amount of process colors in each of the additive 
and subtractive primary color components in an image. 

7. Channel Mixer: The Channel Mixer command lets you modify a color channel using a mix of 
the current color channels. 

8. Gradient Map: The Gradient Map command maps the equivalent grayscale range of an image 
to the colors of a specified gradient fill.  

9. Desaturate: The Desaturate command converts a color image to a grayscale image in the same 
color mode. 



Adobe Photoshop                                                                                     Half Yearly notes 

7 
Rani Mohan 

10. Invert: The Invert command inverts the colors in an image. You might use this command to 
make a positive black-and-white image negative or to make a positive from a scanned black-and-
white negative.  

10. Threshold: The Threshold command converts grayscale or color images to high-contrast, 
black-and-white images. You can specify a certain level as a threshold. All pixels lighter than the 
threshold are converted to white; all pixels darker are converted to black.  

11. Posterize: The Posterize command lets you specify the number of tonal levels (or brightness 
values) for each channel in an image and then maps pixels to the closest matching level. 

Short cut keys for other functions 
Ctrl + D   –  Deselect  
Ctrl + A   –  Select All 
Ctrl+Z   –  Undo 
Ctrl + Alt + Z  -  Step backwards for undo 
Shift + Alt + Z  -  Step Forwards 
Ctrl + C   –  Copy 
Ctrl + X   –  Cut 
Ctrl + V   –  Paste 
Ctrl + T   –  Free Transform 
Ctrl + E   – Merge Down 
Shift + Ctrl + E  – Merge Visible 
Ctrl+r   - Ruler 

Adobe Photoshop Tools 

 

 

The marquee tools let you select rectangles, ellipses, rounded 
rectangles, and 1-pixel rows and columns. By default, a selection border 
is dragged from its corner. 
Elliptical marquee to make an elliptical selection. 
Single row or single column marquee to define the border as a 1-
pixel-wide row or column.  

 Move tool. 
The move tool lets you drag a selection or layer to a new location in the 
image. 
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Lasso and Magic wand tools are used for selections in Photoshop to 
isolate editing to specific areas in an image, or for cutting out portions 
of an image.  
• Lasso tool: The regular lasso tool allows you to make freehand 

selections. Whenever you let up on the mouse button, your selection 
will automatically close, forming a straight line between the start and 
end points. 

• Polygon Lasso tool:  allow you to draw a straight segment (line), to 
make selections. 

• Magnetic lasso tool works similarly to the other lasso tools, but it 
has special powers that can detect areas of contrast, and it will snap or 
move the pointer along the edge you want to trace. With the magnetic 
lasso tool the border snaps to the edges of defined areas in the image 
is especially useful for quickly selecting objects with complex edges 
set against high-contrast backgrounds. 

 Magic wand tool. 

The magic wand tool lets you select a consistently colored area without 
having to trace its outline and is especially useful for quickly selecting 
objects with complex edges set against high-contrast backgrounds. 

  
Crop tool  

Cropping is the process of removing 
portions of an image to create focus or 
strengthen the composition. You can 
also trim pixels using the Crop And 
Straighten and the Trim commands. 

 

Using the Crop too 

 

Photoshop provides the Brush tool and the Pencil tool to let you paint with 
the current foreground color. By default, the brush tool creates soft strokes 
of color and the pencil tool creates hard-edged, freehand lines. 

 

The Clone stamp tool 
takes a sample of an 
image, which you can 
then apply over 
another image or part 
of the same image. 
You can use any 
brush tip with the 
Clone Stamp tool, 
which gives you 
precise control over 
the size of the clone 
area. You can also use opacity and flow settings to control how paint will be 
applied to the cloned area.  

Altering an image with the Clone Stamp tool 
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The Pattern stamp tool lets you paint with a pattern. You can select a pattern 
from the pattern libraries or create your own patterns. 

Replace color in image areas  
The Color Replacement tool simplifies replacing specific colors 
in your image. You can paint over a targeted color with a 
corrective color.  

1. Select the Color Replacement tool.  
2. Choose a brush tip in the options bar.  
3. For tolerance, enter a percentage value (ranging from 0 to 255) or drag the slider.  
4. To define a smooth edge in the corrected areas, select Anti-aliased.  
5. Choose a foreground color to replace the unwanted color.  
6. Click the color you want to replace in the image.  
7. Drag in the image to replace the targeted color.  

 

 

The Gradient Tool creates a gradual blend between multiple colors. You 
can choose from preset gradient fills or create your own.  

The Paint Bucket tool fills adjacent pixels that are similar in color value to 
the pixels you click. 

 

The toning tools consist of the Dodge tool and the Burn tool. Used to 
lighten or darken areas of the image, the dodge and burn tools are based on 
a traditional photographer's technique for regulating exposure on specific 
areas of a print. 

The Sponge Tool subtly changes the color saturation of an area. In 
Grayscale mode, the tool increases or decreases contrast by moving gray 
levels away from or toward the middle gray. 

 

You can create Horizontal or vertical type anywhere in an image.
Point type is useful for entering a single word or a line of characters; 
paragraph type is useful for entering and formatting the type as one or 
more paragraphs. 

When you use the Horizontal type mask tool or Vertical Type Mask 
tool , you create a selection in the shape of the type. Type selections 
appear on the active layer, and can be moved, copied, filled, or stroked just 
like any other selection. 
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Paragraph palette 

 
A. Alignment and justification  
B. Left indent  
C. First line left indent  
D. Space before paragraph  
E. Hyphenation  
F. Right indent  
G. Space after paragraph  
 

 
Character palette overview 

A. Font Family B. Font Size C. Vertical Scale D. 
Set T sume option E. Tracking F. Baseline Shift 
G. Language H. Font Style I. Leading  
J. Horizontal scale K. Kerning  

 

you can use the drawing tools to create a work path; you can draw multiple 
shapes in a layer and specify how overlapping shapes interact 

You can draw multiple shapes in a layer and specify how overlapping 
shapes interact. 

When you're using the Custom Shape tool, you can choose from a variety 
of preset shapes. You can also save shapes that you create as preset shapes. 

Each Shape tool provides specific options; for example, you can set 
options that allow you to draw a rectangle with fixed dimensions or a line 
with arrowheads. 

 

The Eyedropper tool (  ) samples color to designate a new foreground 
or background color. 

If you selected the color sampler tool (  ), place up to four color 
samplers on the image. Click where you want to place a sampler. 
 
The measure tool calculates the distance between any two points in the 
work area. 
The measure tool calculates the distance between any two points in the 
work area. 

Hand tool  
If the entire image is not visible in the document window, you can navigate 
to bring another area of the image into view. 

Zoom tool  

You can Magnify or reduce your view using various methods. 
Select the Zoom tool . The pointer becomes a magnifying glass with a 
plus sign in its center . Click the area you want to magnify. 

The Pointer becomes a Magnifying glass with a minus sign in its center .
Click the center of the area of the image you want to reduce. 
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The points required for designing a greeting card      
        
1. Layout: 

a. Size: Select the height and width of the card is in inches, centimeters 
b. Resolution: More resolution improves the quality of the cards 
c. Colour: It can be RGB (Red, Green, Blue) or CMYK (Cyanine Magenta Yellow 

Black) 
2. Layers: Inserting different layers for images are very important in making a greeting 

card. By using layers we can move/edit and apply effects  to images or backgrounds 
according to our choices 

3. Importing an Image: Before inserting images into the canvas, check images are in 
proper file format, size and the correct colour mode, if not adjust the colour mode and 
size in Photoshop.  

4. Editing an image: Image can be resized using image size command or free Transform 
(Ctrl+T) depends on the size you want. 

5. Inserting and Editing Text: we can insert text directly on the canvas. After entering text, 
we can edit its colour, size, font etc. We can also add effects and word art into the text. 

6. Adding effect: Through Blending options, Layer mode and image adjustments we can 
apply various effects to each layers. 

7. Final File format: After finishing the card in Photoshop the final copy should be in 
JPEG or TIFF format for printout.  

 


